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LEAP INTRODUCTION
 So why do you need a better Finder? As long time (very long time) Mac users, Ted and I have always felt that drop in 
workflow when we had to locate a file in the Finder. Even if you know exactly where something is, it can take many 
clicks to navigate to that place in the hierarchy. It always seems like work to remember where you left things. Why 
after 20 plus years are we still having to navigate folders in order to find something on a hard drive? New Macs are 
thousands of times faster and bigger than those early machines. Let’s use the power. 

With Leap you find things based on your natural memory of that file. Example memory:  “hmm it was a big pho-
toshop file of a basketball court” or “Something I tagged important” or “A word document somewhere in my docu-
ments folder” (feel free to substitute your own here). I have never had a memory of a file like  “/Users/tandersen/
Documents/Project 29/Startup/Images/originals/bball.psd” - but this is the sort of thing that using the Finder 
forces you to think about.

Very quick manual for people in a hurry

 

The crumb trail

Use the crumb trail’s orange source menu to pick what you want to look for and the green menus next to it to choose 
what kind of file you want to look for and where you want to look, optionally narrowing down your search by date, or  
rating. Then to further narrow down your search, select tags, file types or folders from the left tag panel or the loca-
tion panel or by using the crumb trail’s search field. In this case I have done a Spotlight search for items rated one star 
or higher that are located Anywhere (ie on this computer and on any mounted servers), that date from 2006 or earlier, 
and have the tag ‘elias’. 

Another example: Leap vs Spotlight.

Leap allows you to quickly use everything you know about a file to narrow down results. As a comparison -  I do a 
search in the Spotlight menu on my computer for ‘report’ I get more than 10,000 items returned. 

If the document you are looking for is not in the first few results returned, what do you do? Well imagine that you 
know it is a PDF document, and that it has ‘report’ in the title. With Leap it is really easy to restrict your search with 
two clicks - (searches in title only use brown text in the search field):

46 results - much more manageable. Also Leap shows you where on your computer each of the returned files are - so 
you can also use the location of the file to track its location down. This is really powerful - Leap not only shows you 
the results of your search, but it also shows you many possible choices to profitably narrow down your search. 
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Neat comparison between Leap and the Finder: Try using the ‘Go’ menu in Leap and in the Finder to see all of 
your applications. Leap actually shows you all the applications in your applications folder, while the Finder just 
shows you all the folders and some applications. Use Leap to add tags like ‘media’ to all the media apps, use the 
‘Hide’ toolbar command to hide applications that you don’t need to see regularly. In about 5 minutes you can really 
organize your applications in such a way that finding the right app is a snap.

A few more quick pointers

Display method buttons: Use these to switch between thumbnail, grouped thumbnail and list views. In list view, 
right clicking on the header allows you to add or remove columns. 

 

You can search inside document contents using Spotlight or just look for matching file names with the little menu 
inside the search area. When searching by title only, the search text is a brown color to remind you. 

You can make a bookmark for any search that you have done (bookmarks are shown in the area immediately above 
the crumb trail. You can reorder bookmarks in the Bookmarks panel. There is also a button for the bookmarks panel 
at the left side of the bookmarks.

The orange source menu starts out with three important items. Top Level  allows you to browse your computer in 
much the same way as navigating with the Finder - folder by folder. All Files does a deep recursive plumb of what-
ever folder you are looking at in Leap, resulting in often tens of thousands of files displayed. It is good for seeing all 
the files below a certain folder. Spotlight uses Apple’s search technology to search for files, you often use it to enter 
search terms or find all files with a certain rating, date range, etc.

Searching with exclusions - new for 3.0
If you do a content search and preface a word with a minus sign ‘-’ Leap will exclude 
files that have that search term in them. 
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You can exclude a folder by right clicking it in the folder panel. 
You can also hold down the command key and click on a folder 
in the folder list.

You can exclude a file type by picking it from the file type list.

Example Search

One of the main things that Leap does is allow you to look at your files organized in the way you choose, not con-
strained to always thinking about the location on your hard drive. 

You can see files organized by file type, by tag, by content search, rating, etc. And when you pick one search method, 
Leap presents you with a clear choice of your search options to further refine your search. 

For instance, here I have done a search 
for images in my home folder - there 
are about 55 thousand of them. With 
Leap, I can quickly see that ‘only’ 644 
of them are Photoshop files - and it is 
a psd I seek, so clicking on that:

And we are down to 644 items. Then I 
remember that the image is pretty big, 

so I sort by file size, and  I quickly find the file by seeing it in the search results.
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A MORE DETAILED MANUAL
First, I will go through the interface, outlining what each part does. Then I will add some examples. I think that dif-
ferent people will use Leap differently, so I will go through and demonstrate some work flows that are just a few 
clicks with Leap.

THE CRUMB TRAIL

What, where, when, starts the crumb trail. These three menus allow you to determine what (or how) the search will be 
done (orange), where (green) and when (the next menu). In addition, the ratings menu allows you to limit your 
search to items with certain ratings. 

Selected Tags, file types and text searches finish off the display of the crumb trail. The crumb trail is Leap trying to 
describe to you the current search,  determining what documents Leap will show you. Save the current crumb trail 
settings as a bookmark using the menus (⌘ D). 

Further refine the search by adding tags the tags panel at the left of the window, using the file types menu, or by pick-
ing a minimum rating for a file. Filter the results either by file name or by searching the files for a given term using 
the search field. You can switch between search by contents and search by file name by using the little menu inside 
the search area.

The Orange Source Menu
The orange source menu defines the what of your search. It is always used in conjunction with the rest of the items in 
your crumb trail. It is divided into Unfiltered ,Tagged and By File Type Group sections and decides the overall tone of 
your search.

Unfiltered

These items allow you to see all file types in the location that you specify in the Location menu. 

Top Level of Files is our most ‘Finder like’ view. With it, you see a listing of files and folders for a location much like 
you would see in the Finder (except that we allow you to filter these files by type or tag, and you can scale the 
thumbnails to any size you want and you can tag your files. And a bunch of other stuff too.)  Note that in the prefer-
ences under ‘File Type Groups’ you can enable a setting which will show all the invisible files in any folder you are 
in.

All Files (deep) is Leap’s way of showing you all the files at a location, without regard for where they are in the 
folder hierarchy. The easiest way to see the difference between these two views is to try them out on a location such 
as your Desktop or Documents folder. If you deal with large folders full of files, (for example as a web developer, or 
in prepress, etc.), going deep on a folder allows you to find images and other items buried deep inside a folder hier-
archy. 

I r o n i c  S o f t w a r e! L e a p  M a n u a l

6



Spotlight tells Leap to do a Spotlight search on the selected location. You will need to type something in to the search 
field or select a date range or rating to begin your search. If you select Spotlight, the ‘file types’ list switches to all 
registered file types, allowing you to pick an seldom used file type. 

Tagged

With Leap, you can add tags to any file on your computer. Tags help you organize documents in a non-hierarchical 
way. So, for example, you could tag some documents with cottage, some with taxes and some with vacation and some 
with all three (or any combination of the three). You can add any tag you want to any document. Think of tags as 
words that will help you find a document again in the future. In addition to regular tags you can also add two special 
tags to a document: hidden and flagged (you can add these special tags manually, or by using the Hide and Flag but-
tons at the bottom of documents window.) Hidden documents won’t show up in the search results and flagged 
documents show up with a special flag icon.

The Tagged section of the orange source menu lets you call up all your tagged documents quickly by selecting Tagged 
Files. Well, actually only if they don’t have the hidden tag set too! To see hidden documents you will have to choose 
Hidden from the orange source menu. Likewise, if you choose Flagged, you will see all your flagged documents. Hid-
ing a document is a quick and easy way to avoid files that you don’t normally have any interest in or that you don’t 
want to see too much of. The hiding only takes place in Leap or any other application that honors the ‘hidden’ tag, so 
you can still see the file in the Finder. 

Managed

Yep 2 introduces the concept of ‘managed files”. Yep 2 shows all managed files on your computer. You typically set 
files to managed to have them appear in Yep. Picking this menu item allows you to see all documents that are visible 
in Yep. You can mark files as managed from within Leap by using the contextual pop up menu. 

In the contextual pop - up menu for each document there is also an item called “Put in Filed Documents”. You can 
move items into it easily with Leap - the items will be moved to ‘today’s folder’. The filed documents folder is located 
in your Documents directory.  This can help with quickly filing information that you have no time to make filing de-
cisions for, forming a digital paper trail of your activities. Leap also uses the Filed Documents folder as an initial stor-
age location for information such as text scraps, URLs and images (not image files) that are dragged onto it. 

By File Type Group

Every file on your computer has one or more file types associated with it. For example a file may be an image and 
more specifically may be a JPEG image. Leap ships with a number of file type groups that make it easy to search for 
files of a certain type. For example if you choose PDF Documents from the orange source menu then Leap will show 
you all the PDF documents located in the area defined by your location menu selection. Or if you choose Images then 
Leap will show you all your images whether JPEG, GIF, Adobe Photoshop or whatever, as long as the file is an image.

In addition to the built-in file type groups that ship with Leap you can add your own by selecting the Edit File Type 
Groups… item. This will open Leap’s File Type Groups preference dialog. Here you will see all the file type groups 
that ship with Leap. By clicking the “+” button in the lower left you can create your own file type group. You will be 
prompted to select a representative file of the type you wish to add to your new file type group. For example, if you 
wanted to add a “Word Processing” group, you might select a Microsoft Word file. You can then give the group a 
name and add further file types, if desired.  For our “Word Processing” group we might want to show Pages docu-
ments as well so we would select a representative Pages document.
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Some geeky stuff: Leap uses something in os x called a universal type identifier (UTI) to describe file types. UTIs 
describe classes of files, so for example public.image is a UTI that all image files have. When we ask you to select a 
representative file for your file type group, we ask the system to return the file’s UTI to us. Some older file types may 
not have a defined UTI in which case the system creates what it calls a dynamic UTI. (These dynamic UTIs start 
with “dyn.”) But in-order to do this and have the UTI remembered across restarts, Leap requires the file to have an 
extension. If you select an older file that has no extension then Leap won’t be able to create your file type group for 
you.

The Location menu 

The location menu is just to the right of the orange source menu. Use it to set where you want to look. Your selection 
here is reflected in the locations panel (which is described in separate section of the manual). You can use the loca-
tions panel to further limit where you want to look. The locations menu is divided into four sections: Preferred Places, 
Standard Places, Saved Places and Recent Places.

Preferred Places

You can set your preferred places from Preferred Places in Leap’s preferences window. Preferred places are those fold-
ers and locations where you commonly keep your documents. Setting up a number of preferred places makes it easy 
to quickly find files in those places. Your preferred places might be a work folder, your desktop folder, a downloads 
folder or even your documents folder. Selecting All Preferred Places from the location menu asks Leap to look in all 
your preferred places for files. Selecting a specific preferred place limits the search to only that location.

Standard Places

Standard places are handy shortcuts to some common folders and places. Anywhere looks on all mounted volumes on 
your computer, though Spotlight (which Leap uses for most of its searches) will not look on CD-ROMs, some net-
work drives (if the computer hosting the shared drive is running 10.5 Leopard or later, then network search will 
work), and some other types of volumes. Computer looks on all local drives attached to your computer. Shared looks 
on appropriately configured networked drives (i.e. hosted OS X 10.5 or later file servers). 

Go to Folder… lets you pick any location on your computer.

Saved Places

You can save a new place for later access by selecting Add Saved Place. Add Saved Place will be enabled whenever you 
have navigated to a location that is not currently listed in the locations menu. So, for instance, after using Go to 
Folder… to navigate to a folder called Big Work Project, you will see that the Add Saved Place menu item has changed to 
Add Saved Place (Big Work Project). Just select this menu item and Big Work Project will be added to the locations menu 
for access whenever you want. Saved places are remembered across restarts of Leap. To remove a saved place from 
the locations menu, select Edit Saved Places… and remove the appropriate item or items.

Recent Places

Leap keeps track of recent locations that you have used. To clear the current list of recent places, choose Clear Recent 
Places. 
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The File type menu 
The file type menu is just to the right of the location menu. Use it to set what kind of files you want to look. Your selec-
tion here will limit the search to the selected types. If you selected Images from the orange source menu, then this 
menu will show all the file type in the current search. Note that you can use this menu to exclude certain file types by 
holding down the ‘Command’ key as you first click on the menu.  If all the files are of the same type, then the menu 
won’t be shown. There can be many file types returned in any given search, so all the popular ones are shown in 
them main part of the menu and all the others in a sub menu. 

The Date menu 
The date menu is just to the right of the green location menu. Its use is optional, if you don’t care what date the 
documents you are looking for were modified at, then leave this menu alone. When no date range is specified, the 
menu looks like a small picture of a calendar (‘Any date’). 

One thing to keep in mind - the modification dates on files on a computer system may not always line up with what 
you remember - if for instance in 2007 you worked extensively on a large Word document, in your mind you might 
think that the date should be 2007. But if you simply open and make any trivial change in 2009, - the document will 
have a modification date in 2009. 

The Ratings menu 
The ratings menu is just to the right of the date menu. Its use is optional, - when you don’t care 
about the ratings, it shows a ‘hollow’ star at the top (Any Rating). Ratings can be set on files to 
make finding your favorites easily.  

Note the ‘Unrated’ item - it allows you to find unrated files on your computer. Since a typical os x 
computer has over a million files on it, almost all of them unrated, you would usually want to 
only use the unrated menu item for searches in a smaller folder, or for one specific file type - like 
for instance all unrated PDFs. A Spotlight search for all unrated items in my home folder came up with 92,000 items.  

The Search field 

The search field comes after any selected tags or file types - it allows you to narrow down your search by content or 
by file name. There is a small magnifying glass on the left side of it that brings up a menu allowing you to choose 
between a content search and a filename search. 

Here are some technical details on searching by content and filename:

Content search: This is a search very similar to the Finder Spotlight search in OS X: 

To do a search with the ‘same’ results as a Finder Spotlight Search: 1) Set the orange source menu to ‘Spotlight’ then 
type in a search. Make sure the search field is set for content searching.  Leap’s advantages really show up when you 
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are trying to sift through the results to find, as with Leap you can narrow your search by location, file type, tag or 
more with just a few clicks.

Filename search: This is a search somewhat similar to the Finder filename search in OS 
X - only its better and more predictable. You can search for a match in any part of a file 
name. Also typing just one character will find documents that have filenames that 
start with that character.
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BOOKMARKS

The bookmarks bar

Leap’s bookmark feature lets you save the current crumb trail so that you can get back to that search quickly. Say you 
have a search showing your all your Movie files in the iMovie Events folder in your home folder. You can save this as 
a bookmark by using the Add Bookmark menu command ( command - D). You’ll be prompted for a name for the 
bookmark and, once entered, it will be added to your bookmarks bar for easy access. The bookmarks bar is shown 
directly above the crumb trail and it shows as many of your bookmarks as can fit on one line. To see all your book-
marks or to re-arrange, edit names or delete bookmarks press the bookmark button on the left side of the bookmarks 
bar. This will bring up a table of all your bookmarks. To re-arrange bookmarks, simply drag them around in this list. 
You can also add bookmark folders from the main menu’s Bookmarks menu. Bookmarks that are in folders are 
shown as drop down lists in the bookmarks bar, which makes it easy to access numerous bookmarks quickly.

Leap comes with a few pre-loaded bookmarks to get you started. These pre-loaded, default bookmarks (rated, All 
Tagged Files, Applications, and so forth) can be re-arranged or deleted as you wish.

Bookmarks as tag groups: Select a number of tags, for example, “taxes” “receipt” and “family” and then save a 
bookmark. Now whenever you select this bookmark, Leap will search for files with “taxes” “receipt” and “family”. But, 
even more handy, if you drag a file to that bookmark in the bookmark bar then the dragged file will be assigned 
those tags. If fact, when you control-click on a document, the contextual menu that appears will have an item “Add 
Tags from Bookmarks” that lets you pick any of your bookmarks that have tags associated with them. This can be 
extremely handy for quickly assigning tags to documents. 

Bookmarks as file moving destinations too: When you drag an item to a bookmark, Leap will show what it is go-
ing to do to the item. If the bookmark has a specific folder location, then dragging a file to it will move (or hold down 
the option key to copy) the file to the folder.

The ‘Move’ and ‘Tag’ menus at the right side of the bookmarks: Anytime you tag or move a file in Leap, Leap 
keeps track of the tags set, or the place the file was moved to. To apply a group of tags that was just recently ap-
plied, drag a document to that menu - this saves time over re-entering all the tags again. 

One more thing. The Finder has a mechanism to (slowly) set up a search using many criteria. These searches can be 
saved, and show up in Finder windows on the left side. Leap always duplicates this list in the Bookmarks bar. You 
can move this list around, or rename it to a short name, (like ‘f’) to minimize the space it uses in the Bookmarks bar.

Go Menu
Leap includes a menu that mimics the ‘Go’ menu in the Finder.  Check it out.

The applications (Shift - command - A) allows you to see all the applications in your applications folder. Very useful if 
you take a few minutes and assign tags to your favorite applications, group them by task, etc. You can also hide all 
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the applications that you don’t ever expect to use, but may need one day, like the 15 applications that seem to get 
installed when you buy a new printer. Don’t forget you can get to the utilities with (Shift - command - U)!
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THE TAGS PANEL (BLUE PANEL ON LEFT)
The filter panel  is used to narrow down your results into sets of documents that you can 
understand. This panel can be widened or narrowed by clicking on the thumb dragger 
shown in the bottom right of the image, and dragging the mouse. This is useful if you 
use long tag names. In the tag sections, the number of results with the specific tag is 
shown when you hover over a tag. There is a ‘Filter’ section at the bottom of it to help 
you locate tags by name. Just below the filter are 2 icons that control the kind of tags 
shown.

These are tags that have been typed in by you into Leap, or in other OpenMeta applica-
tions such as Deep or Fresh, or found inside the document, such as tags set inside a 
JPEG file using IPTC keywords, etc.  The list of tags  shown in this panel  always reflects 
your current search -  the documents shown in the main document list in Leap. You can 
hide or show these tags with the disclosure triangle just to the left of Tags.  Since you 
can add an unlimited number of tags to Leap, there is not always enough room to show 
them all. When this happens, Leap shows the most popular tags that can fit into the 
space it has. To select a tag not on the list, use the filter to enter a few characters to nar-
row things down. Pressing just one character results in a list of all tags that start with that 
character. Two or more entered characters is used for a content search within the tag.

The All Tags button is in the ‘Action Bar’ which can be shown using the menu command in the view menu.

Tag exclusion

You can select a tag NOT to include in a search by right clicking on it, or by using the command key as you click on it. 
The tag will appear reddish in the crumb trail.

To see all active tags, click on the  area below the tags (where it says ‘Top 19 of 976 
tags’), or use the Window menu to pick “Show Tags Window”.

The tags shown in Leap are obtained from two different places. There are two buttons 
at the bottom of the tags to turn the kinds of tags on and off. A button is on if it is col-

ored blue. (in the example here user added tags are on, while keywords are off).

Button 1 - (small picture of a tag) - Editable Tags 

Show these buttons with the view menu - select ‘Show Action Bar’.

This button toggles the display of tags that you have entered into Leap - these are tags that you can rename, delete, 

etc.  These tags that are stored as OpenMeta ‘extended attributes’ on the file. These tags can be seen by any OpenMeta 
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aware application (the tagging standard that Leap, Yep and other ironic applications use), and searches for these tags 
will work in Leap (obviously) or in the Finder, etc. 

Button 2 - (looks like key) - Read-only Keywords

There are lots of other tags that may be available for a document that Leap cannot edit. These include tags set inside a 
PDF, XMP tags, tags set inside of JPEG files, etc. To keep the distinction straight in your mind, we use the word 
‘Keywords’ to refer to these read only tags. Leap reads keywords from the ‘kMDItemKeywords’ of files as Spotlight 
has indexed them. places.  Keywords set by Adobe Bridge, as XMP tags usually picked up by Spotlight as read only 
keywords in Leap.  The XMP keywords on some file types are not, it seems indexed by Spotlight, and therefore not 
available to Leap.

LOCATIONS PANEL
The Locations panel is a hierarchical view of all the folders that are in the currently selected location. You can adjust 
the width of the locations panel with the grabber at the bottom of the file. Just like the tags panel that I just described, 
it also shows your current search results. Folders with search results in them are colored darker than those without. 

You can narrow down the files that you are looking for by clicking on any bolded 
folder. For example, you click on Images in the orange source menu, then in the 
Locations panel, you can see where in your home account all of your images are 
located. There may be different routes to get to the same folder, just as there is in 
the Apple’s Finder. This listing is useful to see where large groups of documents 
are, or find a document that you know is in the a certain folder on your hard drive. 
In the image shown on the here, clicking on Developer would show the 41 docu-
ments that both match my current search and lie in my Developer folder.

This is a really powerful feature. For the first time you can do a search, and ‘see’ 
where the results are. 

NOTE: Clicking on a folder will limit your search to that folder.  If you click on a 
dimmed out folder, you will see that there are no documents that match the current 
search in that folder.  Clicking on a selected folder will unselect it, therefore widen-
ing the search to include all the files shown in the Locations panel.

NOTE -2: There is a button at the bottom of the panel that has three lines with a 
small up arrow below it. This button takes you up one in the hierarchy. This 

button is also available in the main toolbar. 

The pop-up menu in the Locations panel allows you to see the folder in the Finder, or reset your location to the 
folder(‘Constrain to Folder’), or save the folder as a place in the Location menu.  It also allows you to create a folder 
in the Finder underneath the selected folder. In addition a button with a ‘+’ symbol on it next to the ‘up’ button will 
create a folder under any selected folder.

Moving and copying files

Leap allows you to move and copy files using the Locations Panel. Here are some hints:
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If you make a selection of one or more documents in the document view then drag them to the Locations Panel, 

you can drop the files anywhere. The panel will expand, allowing you to ‘go - into’ folders and sub-folders. This is 
similar to the Finder’s spring loaded folder feature. If you hold down the option key while dragging, Leap will copy 
the file(s) to the folder you drop on. The default is to move the file(s). 

In Apple’s Finder, I personally don’t use the spring loaded drag and drop all that often - I find that I sometimes let go 
of the mouse at the wrong time, and my file gets put in some random location. To combat this problem Leap has a 
confirm dialog that lets you decide whether to go through with, or cancel the file operation. This dialog can be dis-
abled in the preferences.

In Leap 3.0, Leap performs the file moves and copies itself. Note that large file transfers will not happen ‘instantly’ - 
leap may pause until the transfer is done. You may want to move extremely large files using the Finder.

If you drag a file out of Leap and into a Finder window (or the Desktop) the Finder will do a copy of the file. There 
seems to be no way for Leap to control this behavior. So after some file operations,  you may want to throw the origi-
nal file out. 

Trashing a file:

To delete a file from your hard drive, right click it and select move to trash, or just select it, then press command - 
delete. The confirmation for this process can be turned off in the preferences.  
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DOCUMENT DISPLAY
Leap can show documents in three ways: Thumbnails, or grouped thumbnails or in a list view.

      

This is where your search results - the documents you are working with - are displayed. Leap uses Apple’s Quick-
Look technology to display documents by showing a small image of the actual document. (In list view it shows file 
type icons). There is a slider at the bottom of the screen for controlling the size of the thumbnails. In the thumbnail 
view as shown in the image here, the file name for each file is shown along with any tags that have been set on the 
document. Using the preferences, you can turn on and off the ‘border effect’ for various kinds of files. Images look 
nice with borders, but if you are a graphic artist it can be nice to have them off, so you can see the real image, with 
transparency, etc. 

Twenty or so tips about document handling in Leap:

• Double click on any document to open it with its default editor. If you right click you can see a list of other appli-
cations that will open that document. Or you can drag the document to an application in Apple’s Dock.

• Set tags on files right in the document window. Just click on the tags, (line under the file name) and type new tags. 
Or click on a document and press the enter key. To go to the next document, just hit the tab key.
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• Setting tags - click on a document and press the enter (not the return) key to bring up the tag editor. If you have 
multiple documents selected, this also brings up a (slightly different) window that allows you to set tags in multi-
ple documents.

• Tags can also be set on multiple selections by using the ‘Get Info’ command from the File menu, which brings up 
a get - info window.

• Inspectors and Info windows. Leap has both: An info window, once opened, will show information for a particu-
lar document until you close it. This means that you can get many info windows open at once.  The inspector 
shows the exact same content, but the inspector changes documents as you select different documents in Leap. The 
inspector always opens as a panel on the right side of the window, while info windows open as separate windows.  
If you find that you want to compare two files information at the same time - just use the File menu’s ‘Get Info’ 
command (option - command I) to bring up a separate info window for the other file. 

• Inspector/Info windows can be used to add notes, and copy a fairly complete if somewhat nerdy ‘Copy to Clip-
board’ button which shows a plethora of useful and useless information as gleaned from Spotlight’s database.

• Rename files by simply clicking on the document file name, or selecting a document and pressing the return key. 

• Select multiple items using all the ‘usual’ Mac ways - by clicking and dragging or by clicking on one document 
then holding down the shift key and clicking on another document to extend the selection. Command key + click is 
used in the usual Mac way to make discontinuous selections (ie: a selection from documents from all over the 
place).

• The toolbar at the bottom of the document display allows you to Open, Print, Email, Reveal in Finder, Edit tags, 
Hide and Flag any number of documents that you have selected. 

• If you drag items from the document display into a Finder window, the Finder will put a copy of that file into the 
folder that you dragged to.

• Don’t forget that you can right-click on a document to bring up a menu that allows you to add and remove tags 
without any typing. 

• Dragging a document to a tag in the tag pane will add that tag to the document.

• QuickLook - If you select one or more documents and press the space bar, you will get a QuickLook viewer for that 
file, similar to the Finder.

• You can move and copy items around with Leap: make sure the Locations Panel is displayed (button in top toolbar 
with three lines), then drag the document(s) into any folder you want them to move to. To force a copy instead of a 
move, hold down the option key. Sometimes, even if you ask it to move, Leap will have to copy the files, for in-
stance if you try to move files from a CD onto your computer, Leap will have to copy, as the CD cannot be modi-
fied.

• Drag files out of the document window and into other applications, such as Word, Mail, Photoshop, etc.

• You can also drag items into the document display. When you drag items in, Leap will change the current search 
into one based on the files/folders that you have dragged in. When you drag a folder in, Leap will show you all the 
files in that folder. This is great for projects (i.e.: any ‘big thing’ you are working on). Drag the project folder into 
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Leap, select ‘Go Deep’ and all of a sudden you are able to actually see the contents of the project in 
‘living color’. Sorry if I got a little excited there, but I have found that when I do this I find files that I 
have forgotten about, things that should not be in the project, etc. It is a really great thing to do 
when you are handed a new project to have a look at or contribute to. After you drag the project file 
in, don’t forget to look at the File Types section in the tags pane. Then you can click through, seeing 
all the images, word docs, etc, etc that are in the project. You can save these drag - ins as bookmarks. 
Also very useful if you are about to send out a large project folder. You can see that there are no sur-
prises in the folder. Just do a ‘All Files’ search on the folder, perhaps even with hidden files turned on.

• You can throw files out using Leap. Just select the documents then use the ‘Move to trash’ icon in the toolbar, or 
faster, use the keyboard Command - Delete sequence. Leap will have a dialog asking if you really want to throw 
out the files, and if you do, Leap will move the files to the real trash on your computer. Use Leap’s preferences to 
turn off that warning. Don’t forget that files on remote volumes may be deleted immediately. 

• Printing. When you select one or more documents in Leap, and press the print button in the toolbar, Leap will ask 
the computer to open and print each document. For example, if you ask Leap to print a Word document, then Mi-
crosoft Word, or whatever application you have set to open Word documents will open up and print the document. 

• Printing a listing of all documents in the Document Display: If you want a listing of all the documents in the 
document display printed, use the “Print Search Results” command in the File menu. It will create an HTML table 
of the items in the display, and issue a print command for that. NOTE: When you print search results, Leap uses 
whatever columns you have turned on in the list view to create the html. This is handy to get a print out of files 
that you will be sending to a printing shop, etc.

• If you are working on a document in an application such as Pages, Word, Photoshop, etc., you can drag the little 

icon at the top of the document, just left of the document name  from the other application 
into Leap. This allows you to set tags, notes, etc on the document.  

• Sorting: There is a menu at the top of the document display area that allows you to select how you would like the 
documents sorted. This works in all three display modes.

• The document display area actually has three ways to view files: Thumbnails, as is the default view, list view, and 
the ever popular grouped thumbnails, which allows you to see your documents grouped by whatever sort method 
you have selected. Use the three buttons at the top of the main Leap window.

 

• When in list view, you can select which columns you would like to see by right clicking on the column name bar at 
the top. Columns can also be moved around by clicking in the name bar and dragging. The columns that are 
turned on also set up how your printing search results will work.
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• Exporting: When you select ‘Export Search Results...” from the File menu, Leap uses the columns that you have 
turned on to generate an html table. Programs such as Microsoft Excel and Open Office can import the html either 
by copying and pasting from Safari, or as a direct import.

• Time Machine support: - We think that this is a big feature. Personally, we find Apple’s Time Machine interface to 
be a little too ‘spacey’.  If you use time machine as a backup system, then Leap can show you all the revisions of 
any backed up document (as long as it has not moved location) in the Time Machine 
backup volume. You need to mount the time machine backup drive first (for Time 
Capsules you may need to open the disk image), then Leap will search the drive to 
show you all versions that are available. For example for this document that I am typ-
ing, I dragged the title bar icon into Leap, so it was easy to find, then I right clicked on 
it, and selected ‘Show Time Machine Revisions’ , first making sure that I had mounted 
my Time Machine disk (in my case a Time Capsule). Leap grinds away for a little 
while, then comes up with 5 versions of the document: Sorted by date below. The con-
tents of the Time Machine disks are read only, so you would normally copy a file to the 
Desktop or similar in order to edit it, or to copy portions, etc. You can figure out which 

one to pick by using QuickLook (spacebar).

THE LOUPE
The magnifying glass, or loupe as Leap calls it, is a very handy tool for 
looking at details in images, PDF documents, HTML pages, etc. You 
can adjust the size and look of the Loupe using Leap’s preferences. You 

can turn it on with the  button in the toolbar at the top of the 
screen, or by holding the option key down as you mouse over a docu-
ment (that is how I usually use it). Note that it also works in list mode. 
You can set it to show the entire thumbnail, or to behave more like a 
traditional magnifying glass. 
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LEAP PREFERENCES
Don’t forget about them! One important thing is to make sure you set up all your favorite file types. To get a file type 
for a file that is not listed, pick the ‘plus’ button at the bottom of the file type preferences, then select any example of 
the file you want to track.  

How to group together several file types: In the preferences, go to the File Types panel, then add a new file type, and 
pick a file of the type you want to add, then when you see the dialog like the image below, press the + button to add 
more document types. Remember you have to pick the documents, not the applications that open them.

 

Details about tagging, keywords, spotlight comments, and XMP

Leap allows you to add tags to any file. When you add tags to a file, Leap does not alter the file contents, rather it 
stores the tags in the files extended attributes, using a technology called OpenMeta. For more info on OpenMeta 
please see the OpenMeta open source site at http://code.google.com/p/openmeta/ 

Read only Keywords

Keywords and tags are virtually synonyms. Leap uses keywords to refer to ‘read only tags’.  Some files have key-
words that Leap can only read, and cannot change. For instance, in a PDF, there is space to add keywords when creat-
ing the PDF. Some Image formats have a place for keywords. Many images from stock photography houses have 
keywords set in them. Leap obtains these read only keywords from the Spotlight database: These are keywords that 
spotlight has stored for some files. They can come from many different places. 

Preferred Places: This is where you set your locations up for the ‘Preferred Places’ item of the Location menu. You 
should only add folders here for places that you usually keep files in, that way, when you do a search for images, for 
instance, you will not get all the thousands of images on your entire computer, but rather only those in the folders 
where you usually work. 

Excluding certain folders from results. Many people have an iTunes library with many thousands of songs in it. If 
you want to track music and sounds with Leap for work purposes, and you keep getting too many of your iTunes 
songs mixed in, then you can hide all your iTunes music from Spotlight with a Spotlight Privacy folder. The tracking 
preferences will show you a bit more about it. iPhoto is also bad for this, as it makes several versions of each image. 
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This is fixed in iPhoto version 7 or later. Since you manage your photos with iPhoto, adding the folder Pictures/
iPhoto Library to Spotlight’s privacy folders will hide those images from Leap.

Servers: You can add servers to this list of tracking folders. Be warned, however that almost all searches on servers 
are very slow when using Tiger. With OS X 10.5 Leopard on both server and client, searches work very well across 
the network. This is a very good thing.

SEARCHING IN APPLE’S SPOTLIGHT
Why would you ever do that again? OK, so you type the word ‘proposal’ into Apple’s Spotlight. If you use Leap’s 
spotlight tagging feature, any document that you have tagged with the word proposal will come in with the results. 

In the Finder, you can specifically search for a tag using the syntax

tag:proposal 

This would only find documents that are tagged ‘proposal’ on your system. This works with any tags set with 
OpenMeta. 

You can also search for rated items, by opening a Finder search window and using the Other... little menu to pick 
Rating as a  field, then use that.

BACKING UP

Backing up data

Leap does not backup any of your documents. You need to run Time Machine, or a similar product to back up all 
your files. My experience over the past 20 years has been that hard drives and or computers suffer massive failures 
every few years (or sooner!). If you don’t backup your documents, they won’t be around for long. Sort of like the sign 
I saw at the dentists once: “You don’t have to floss all your teeth, just the ones you want to keep”.

Backing up tags and ratings

Leap does make backup files of the tags for every item you tag as you tag them. This allows Leap to restore tags and 
ratings to files that have had them stripped off, which can happen when editing files with Adobe CS4 and a smatter-
ing of other applications. These backup files are stored in ~/Library/Application Support/OpenMeta (not the Leap 
folder, as all OpenMeta applications use the same system).  This folder is backed up with normal Time Machine set-
tings. You will have to create the folder ~/Library/Application Support/OpenMeta manually if you want this fea-
ture to work, this is due to sandboxing rules in OS X 10.7.

Backing up tags and ratings manually
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The backup files that Leap makes do form an effective backup, - but there are ways in which these files may be in-
complete, such as when a tag is added by another application that doesn’t make backup files. Also if you are about to 
reformat a hard drive, or other drastic step, then you may want to backup your tags to a single file. To do this run 
Leap, then from the File menu pick “Backup metadata”. A dialog explaining the process will come up, and later, 
when the file is made, a dialog similar to the one shown above will be shown. 

Restoring from backup

Leap supports restoring from the above two methods of backup, plus it also supports the importing of metadata from 
old Yep 1 or Leap 1 data files. To do any of these operations, pick “Restore Metadata…” from the File menu, then in 
order to tell Leap which kind of backup to do, pick one of:

a ‘.omsback’ file that you made in an earlier manual backup,

a docInfo.plist.gz file from an old Yep 1 or Leap 1 install or

the OpenMeta folder in your Application Support folder. 

In all three cases Leap will restore tags and ratings to any file it can find in the backup file, being careful not to over-
write newer tags with older ones. Leap stores the path and an alias to the files it makes backups for, and it tries to 
find the file to restore to using both these methods. Leap will also finish a restore operation with a dialog informing 
you of the results. If Leap has to set tags on documents that you need to authorize with a password in order to mod-
ify, a dialog will be presented for that. This security authorization for Leap to alter files only lasts a few minutes, so 
there may be a few of these if there are a lot of files in system areas that you are tracking. 

Adding tags in Spotlight Comments to Leap

Other programs, or older versions of Leap such as version 1.1 used Spotlight comments to hold the tags for a docu-
ment. In order to import these tags into Leap, use the “Add Comment Tags to OpenMeta” menu command. This will 
read tags from a few formats found in comments, including &Tag1, @someTag, Punakea formats, and a few others.  A 
dialog will appear asking if you want to erase the spotlight comments when the tags are safely added to OpenMeta. 
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REAL LIFE FICTIONAL WORK FLOWS
Leap allows you to find files in whatever way you decide. It can take a little while to understand how useful this can 
be, so I include here a few workflow examples:

1) You are a super - cool website designer, and someone has just hired you to edit their website. Upon downloading 
the site to your computer, you are presented with much more than the usual somewhat disorganized mess of over 
a thousand files spread out over many folders. With the Finder you are reduced to hunting through folders for 
html, css and image files. Drop the folder onto Leap, and you will see right away that there are say 12 css files, 300 
images, 45 html files, some files you have never heard of before, and a sandwich. (actually not a sandwich - that is 
my stomach talking). A few clicks and you can find the corporate logo (a gif file called 23.gif) and the Loupe shows 
you that the support page on the site is called sport.html. 

2) You are a super - cool writer who has never really filed anything anywhere in their life. Then someone phones up 
and says “remember that contract that I emailed you a while back?”. A quick click on your mail downloads folder 
in Leap, and a file called contract.pdf is there. And one click to find all the Word documents in your account. It 
turns out that all that ‘filing things in the right folder thing’ that you neglected to do worked out just fine.

3) You are a super - cool casual computer user who relies on some ‘computer expert’ (son, friend, etc) to do set things 
up for you. After they set up Leap on your machine, all your favorite documents show up with just a click or two. 
You no longer lose as many documents as you used to. 

4) You are a super - cool computer programmer who has to deal with all sorts of projects. Finding the right image to 
use in a large project can be daunting. Leap allows you to see all the images in your source tree with a click or two. 
It is also really great for finding files that should not be in your project. Don’t forget Leap’s Show Package Con-
tents command on the pop-up menu for each bundle - it is really handy for finding images inside of applications 
and bundles.

5) You use Apple Mail, Pages, Photoshop, Final Cut Pro, and 4 other applications all day, working on jobs for various 
clients. With Leap you can add a tag for each client name to every document you work on, allowing you to both 
find your work and also invoice appropriately. With tags you find you can also tag emails from the client - so a 
click or two in Leap finds all the documents, emails, and notes that you may have spread out over several hard 
drives.

6) You are a networking expert, and you note how nice it is that everyone on the network can add tags to files on the 
shared server, creating a little more order out of the chaos. 

7) You can organize your applications using Leap and some simple tags: Add the filetype for applications to the Pref-
erences, then when you click on this in Leap, you get all the applications on your computer. Useful, but tends to 
contain a lot of items. Then go through the list, adding tags like ‘media’ to QuickTime, iMovie, and others, ‘utils’ to 
your favorite utilities, etc. Then when you press ‘command shift A’ in Leap, one more click will show you all your 
favorite utilities, or all your media applications. Tags allow a single application to be in more than one category at 
once.

! ! ! !
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